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Getting started with QGIS

Objective
This tutorial will cover following objectives
e To download Quantum GIS (QGIS)
¢ Installing Quantum GIS
¢ Getting familiar with QGIS interface
e Installing a plugin
¢ Adding Vector and Raster data layers to QGIS map Canvas

Software: Quantum GIS

Level: Beginner

Time required: 4 Hour
Prerequisites and Geospatial Skills

1. Basic knowledge about computer.
2. Internet Connection

Reading
1. Sutton, T., Dassau, O., & Sutton, M. (2009). A gentle introduction to GIS. Chief
Directorate: Spatial Planning & Information, Eastern Cape.

Tutorial Data: Tutorial data can be downloaded from IGET GIS 001
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Introduction

Quantum GIS is a free and open source GIS application. It was a result of SourceForge project,
QGIS is developed using C++ and Qt toolkit. Initially QGIS developed for displaying the GIS
data, now it evolved as full GIS software package. It is published under GNU Free
Documentation License as an official project of Open Source Geospatial Foundation (OSGeo).
It is compatible with all the operating systems and can very well handle multiple raster, vector
and databases functionalities. QGIS is also serves as a window for assessing numerous other
Open source GIS packages such as SAGA, GRASS, Post GIS, map server and also statistical
package like ‘R’ etc. It also has very easy and convenient access to various tools and plugins. It
is overall a very rich open source Geospatial tool.

Exercise 1: Downloading QGIS

As mentioned earlier, it is free software and can be downloaded from the internet. We will see
how to download QGIS (Windows compatible version) in this section. The only basic
requirement for downloading QGIS on your system is availability of Internet connection. If you
already have QGIS installation file then skip this section and directly proceed to the Exercise
No. 2. If not, the procedure for downloading is as follows:

1. If you want to download the installation file, open the webpage of QGIS, i.e.,
“http://www.qgis.org/” in any of your internet browser like, Internet Explorer or Mozilla

Firefox.

2. The following website will open up in your browser. Click on “Download Now” button.

Q = DISCOVER QGIS FOR USERS GETINVOLVED ~ DOCUMENTATION English

A Free and Open Source Geographic Information System

QEIS 2.0

QGIS 2 has a fresh new look ...

3. You will be redirected to new page. Depending on your operating system you have to
select an appropriate set. Here we will consider windows as our operating system.

4. Depending on your computer architecture i.e., 32bit/64bit, select the appropriate

version of QGIS for download. Just click on the & button in front of appropriate version
to start the download.

:_,%'_Eft 3
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Note: You can check for this by My Computer =2 Right click = Properties ?System type.

Q E DISCOVER QGIS FOR USERS GET INVOLVED DOCUMENTATION — English H

INSTALLATION DOWNLOADS ALL RELEASES SOURCES

Download for Windows

For New Users:

M QGIS Standalone Installer Version 2.0.1 (32 bit) &

@ m V QGIS Standalone Installer Version 2.0.1 (64 bit) =g

For Advanced GIS:

AN,

L) {\A_ 05Geo4W Network Installer (32 bit) o
05Geo
AR

LR 05GeodW Network Installer (64 bit) -

0SGeo
'n the installer choose Desktop Express Install and select QGIS to install.

5. A pop up window as shown below will appear. Click on ‘Save File’> Save the file in an
appropriate location on local hard drive>’OK’.

Opening QGIS-0SGeodW-2.0.1-2-Setup-x86_64.exe X

You have chosen to open:
=] QGIS-05GeodW-2.0.1-2-Setup-x86_64.exe
which is: Binary File (185 MB)|
from: http://download.osgeo.org @

Save File ‘ l Cancel l

6. The file will be saved in your local drive, once it finishes the download. Next step is,
running the setup. We will see this in next exercise.

Would you like to save this file?

Exercise 2: Installing QGIS
Once you have the setup file on your local drive next step is to run this setup to install QGIS on

your system.

7. Navigate to downloaded setup file of QGIS. And double click on the icon. If you
prompted by ‘User Account Control’ popup window, click on ‘Yes’.
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| ] -
m“, b Computer » Local Disk (0:) » Downloa

Organize = Open E-rnail Burn Mew

7 Favorites =
Bl Desktop

| Downloads
“Zl Recent Places

4# Dropbox

H e QiEIS-05GendW-2.01-2
-Setup-xB6_564

@ Documents

8. The setup window will open. Click on ‘Next>’

Welcome to the QGIS Dufour (2.0.1)
Setup Wizard

This wizard will guide you through the installation of QGIS
Dufour (2.0.1).

Itis recommended that you dose all other applications
befare starting Setup. This will make it possible to update
relevant system files without having to reboot your

computer,

Click Mext to continue.

9. In the next window you will be presented with ‘License Agreement’ read it and then,
click on ‘I Agree’.

E?E:t 5
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" # QGIS Dufour (20.1) S

License Agreement
Please review the license terms before installing QGIS Dufour (2.0, 1),

Press Page Down to see the rest of the agreement.

:,it:ense OVErview:

1. QGIS

2. MrsID Raster Plugin for GDAL
3. OGR FileGDE Driver

4, ECW Raster Plugin for GDAL
5. Oracle Instant Client

1. License of 'QGIS'

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install QGIS Dufour (2.0, 1).
(o)

10. Now you have to choose the installation location, you recommended to keep the default
path and click on ‘Next’

Mullsoft Install System w2, 46

"/ QGIS Dufour (20.1) Se i
Choose Install Location
Choose the folder in which to install QGIS Dufour (2.0, 1). ‘gg*

Setup will install QGIS Dufour (2.0, 1) in the following folder. To install in a different folder,
dick Browse and select another folder. Click Mext to continue.

Destination Folder

Space required: 867, 7MB

Space available: 12,368

Mullsoft Install Swskem w2, 46
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11.In the next window, you prompted to choose the different components of QGIS and
datasets, if you interested you can check the component you want to install or leave as
default. Click on ‘Install’ to proceed to the setup.

Choose which features of QGIS Dufour (2.0. 1) you want to install.

Chedk the components you want to install and unchedk the components you don't want to
install, Click Install to start the installation.

; Description
Select components to install: g
Position your mouse

[ Morth Carolina Data Set Over & component to
[ south Dakota (Spearfish) see its description,
[] alaska Data Set

Space required: 367, 7MB

Mullsaft Install System vz, 46

In=talling
Please wait while QGIS Dufour (2.0, 1) is being installed.

Extract: gpu_program_parameters.py

Extract: framebuffer_blit.pyc

Extract: framebuffer_multisample. py

Extract: framebuffer_multisample.pyc

Extract: framebuffer_object.py

Extract: framebuffer_object.pyc

Extract: framebuffer_sRGE.py

Extract: framebuffer_sRGB.pyc

Extract: geometry_shader4.py

Extract: geometry_shader4.pyc D
Extract: gpu_program_parameters.py =

Mullsoft Install System w2, 46

< Back Mext = Cancel

13. Once the entire installation process is over, you will be prompt to close the setup click
on ‘Finish’ to close.
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Completing the QGIS Dufour (2.0.1)
Setup Wizard

QGIS Dufour (2.0.1) has been installed on your computer.

Click Finish to dose this wizard.

®
|I | Cancel |

14. Now QGIS is ready to use. Navigate to ‘Start 2 All Praograms 2 QGIS Dufour 2 QGIS
Desktop 2.0.1°, to start QGIS Desktop.

l ¢ INEL FIWULELLW SVl

, QGIS Dufour

M msys
() DSGendW
% QGIS Browser 2.0.1

% QGIS Desktop 2.0.1
[m7] SAGA GIS (2.1.0)
(0 Setup

| GRASSGIS6.4.3

Deahtal =

Note: QGIS 2.0.1 a standalone application and a new panel called Quantum GIS Browser
along with the Desktop same as QGIS 1.8.0. Browser help to navigate through the datasets
and also allows you to preview the data while desktop help in creating, visualization and
analysis of data.

15. Both the interfaces are shown below.

E?f:t 8
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@ Oracle
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i QGIS Desktop GIS Browser
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Q@ Time.
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Exercise 3: QGIS Graphic User Interface

In this exercise we will look into the details of QGIS graphic user interface. This exercise will
make you familiarize with QGIS user interface. As we have already started up with the QGIS
desktop. We will now see different component in it.

£ QGIS 2.01-Dufour

Project Edt View Llayer Settngs Plugns Vector

Raster

Database Processng  Help

! Menu Bar

e

D IR FOB L LA RPLARS Ce N ReEEa-O 5 @ Tool Bar_|
|_7: At r_f:._‘w »; 5 ng we [wy @y :m:‘ n.; il ”l_m ‘L@ m Ll!ﬁ M ML @
Layess
Va
"
L3 Map Layer/
£ Legend
»
N s
L) Shortast path .
£ | == Map View
o
@
Stop
@
@j@ Criterion Length -
’ Length
Time
v;v
Calcuate Export Clear
EE 5% Help
-
Status Bar ‘Cnnrdmatﬁ: | 4,54,5.04 |[scae || 17423885 |~ \@lﬂx Render | zpsci432s [[@)]

As seen in the above figure the interface is divided into five main components, they are further
divided into more sub-components which facilitate easy access to the tools. Now we will go
through each component in detail.
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16. Menu Bar: It contains numerous pull down menus to administrate the project files. It
Provides access to various QGIS features.
a. Using Project menu we can open, save and create new quantum GIS projects. We
can also make attractive map compositions using Composer Manager.

b. Edit menu contains editing tools mostly corresponding to vector layers and these
functions are enabled only when layers are toggled, in other words when we
enabled the editing mode.

c. View menu contains tools to map navigation, selecting features, identifying
features, Measurement tools, contains tools to manage bookmarks, toolbars and
panels.

d. Layer menu contains various tools to load layers like Vector layer, Raster layer,
PostGIS layer, spatialite layer etc. It also facilitates to create new shapefile layer.
You can query the attribute data using Query feature. Convert layer from one vector
layer format to another using save as feature. You can view layer properties and also
possible to do labeling using Labeling feature and many other tools we can discuss
about them later.

e. Settings menu contains tools to set and manage custom CRS, keyboard shortcuts,
style manager, customization and snapping options.

f. Plugins menu actually makes QGIS more powerful. Plugins are small software
components which add a specific ability to the QGIS application. Various core and
third party plug-ins can be accessed and managed by using this toolbar. We also
have ‘Python Console’ from where we can execute python code.

g. Vector menu contains various Research, Analysis, Geoprocessing, Geometry and
Data management tools using which you can do extensive geospatial analyses on
vector data sets. You can also download Open Street Map data here.

h. Raster menu contains various tools such as Georeferencer, Interpolation, tools for
Terrain analysis, Zonal statistics, defining projection, Analysis tools and very
important Raster calculator to perform raster operations.

i. Database menu contains database manger which is a non official part of QGIS core,
you can drag and drop contents from QGIS browser into the DBmanager. It can
execute SQL queries against spatial database. You can directly import shapefiles to
PostgreSQL using spit.

j. Processing menu is an added up menu in this version of QGIS. It has a very useful

Tool box (facilitates to use various Digital Image processing tools) and Graphical
builder.

= 10
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k. Help menu helps to access various help sections of all the functionalities available

in the QGIS.

17.Tool Bar: Provides easy access to all the tools discussed above and with some
additional tools for easy interaction with the map canvas. Each tool in toolbar is
associates a pop up information. Hold the mouse pointer on any of the tool for a while
then you will notice a short description in a small pop up window. Toolbars can be
moved and dropped wherever you wish. We can also enable disable toolbars by right
clicking on toolbar menu. Checking and un-checking the check box in front of tool name
will enable and disable that toolbar respectively.

P —

= v

i

£ %/ Browser

% Toobox

OAd\ranced Digitizing

x| web

Browser (2)
Coordinate Capture
GPS Information
Layer order |
X Layers
Log Messages
Overview
X Shortest path
Tile scale

Undo/Redo

% Attributes
Database
Digitizing

X/ File

X GRASS

X Help

X Label

X Manage Layers

X Map Mavigation

¥ Flugins
Raster

% vector

=@

18. Map Layers/ Legend component is useful to set visibility of the layers and Z-ordering.
Z-ordering means the layers listed on the top of the layer are drawn over the layers
which are listed below. It is always recommended to place Point layers on Line layers

and Line layers on Polygon layers.

a. The check box in-front of layer name is used to draw and draw off the layer. It is
possible to rearrange the layer order by just dragging and placing it wherever

required.

b. It is also possible to group the different layers. Just right click in Layer bar and click

on ‘Add New group’.

c. You can rename the group by (right click over the group - Rename) and add the
required layer in that group by using simple drag and drop method.

11
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Layers Layers

E-- % %/ IND_roads

= [ buildings

El{ x ) points

@
@ E- % %/ IND_roads
E|O buildings

% TND_DATA

X Expand All

4 Collapse Al
Layers | B¢ | Update Drawing Order Layers | Browser

d. You can enable the context menu by right clicking on any of the layers. Context
menu varies for different type of layers like, it may be different for raster and
different for WMS layer. You can use various functionalities available in context
menu for analysis of the desired layer.

19. Map View: It is very important component in QGIS. This section dedicated for
displaying of vector or raster data. It is also referred as map canvas. Any function/tool
that you perform through Menu bar, Tool bar, or in Legend, the result of the tool will be
reflected in map view/canvas.

20. Status Bar: It displays the current coordinates, where the mouse pointer is pointed in
map canvas. It also shows the scale of the map and map rendering option to enable or
disable map rendering.

| Coordinate: || 84.20,7.50 | Scale || 117652713+ ||x Render

a. Using ‘CRS status’ [@] tool in status bar, you can set required coordinate reference
system for the project (Just for visualization).

b. ‘Toggle extent and mouse [] pointing’ tool button is used to see
the extent of current zoom of the canvas layer.

@| Extents: | 54711236

Exercise 4: Installing QGIS Plugins

As we have discussed earlier, plugins have made QGIS more efficient. This can be easily
downloaded using ‘Plugins’ menu bar. The only requisite for downloading plugin is an internet
connection. Before going to downloading plugins we will learn how to do proxy settings that
may be required for some of the network connections. For example if you are using your
college Wi-Fi or Airport Wi-Fi connections. If there is are no proxy settings for your network
connection then you can directly proceed with the download procedure.

2 12
d
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21.Proxy setting
a. Go to ‘Settings’ in menu bar and click on ‘Options’.

-Dufour

(2)
View Layer ] Setlings >PL,/ Vector R
=] =] % CustomCRS...
]

w’ Style Manager...
| ] oo ( &, Configure shorteuts. ..

4 = e .

Customization. ..

b. Then ‘Option’ window will open up. Navigate using arrow keys at top right corner of the

window to ‘Network’ tab. Click on ‘Network’ and the network setting window will open

== & R
Opii L8 [t
o eRaMAssans ()
- = 0)
*  General =
S Application —
“@ System
Style (QGIS restaré requie) Plastique -
ita S
e Tcon theme default |~
}‘( Rendering Teon size 24 |~
Canvas & Legend Font ® Qtdefault ) (M Shell Dig 2 see (s |5
m — Timeout for timed messages or d.a\ugfs =
0 Hide splash screen at startup Show tips at start up
| Digiti
(57 ogitang Bold group box titles | || QGIS-styled group boxes
-~
Gi!:l-\ GDAL Use live-updating color chooser dialogs

% CRS Project files
Locale Open project on launch | New -
|E,.,_ o ]
Create new project from default project

Set current project as default | Reset default

Template folder [C:/Uisers Prachi/.qgis2//project_templates Browse Reset

% Prompt to save project and data source changes when required

%! Wiarn when opening a project file saved with an older version of QGIS

Enable macros | Ask = @

c. Click on the check box in front of ‘Use proxy for web access.” So that the fields
which are needed to be filled will be enabled.

d. Provide proper details of host and port, and also username and password if exists in
the respective fields. (This information can be provided by your Network
administrator). Keep the proxy type as HttpProxy.

e 13
d
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-
./ Options

Network
x General

= General
w@ System
WMS search address | http://geopole.org/wms search?search="%1&type=rss

Data Sources Timeout for network requests {ms) 50000 :
@‘( Rendering Default expiration period for WMS-C/MMTS tiles (hours) 24 =

Canvas & Legend Cache settings

m Map Tools Directory | C:/Users/Prachif.qgis2/cache/

['3"] pigitizing Size 51200 = Clear

-~
Ay
iy coaL @ v@ Ty e @

w@ CRS Host [ 192.168.1.2
E iocis Port 80
b

| User Student
- - Metwork 5 1

Password oy

Proxy type

Exclude URLs (starting with)

[

e. Click ‘OK’ to save proxy setting.
22. Downloading Plugins:

a. Go to ‘Plugins’ in menu bar and click on ‘Manage and Install Plugins’.

/4 QGIS 2.0.1-Dufour @

Project Edit View Layer Settings M ‘ector

D _E Q “"+ Manage and Install Plugins. ..
L = | m ) —

.. Python Console
e O GRASS
W 5 - 2 2

- W P =y

Raster

Databasze

b. The ‘Fetching Repositories’ window will open up where list of available plugins are

displayed.

14
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r hl
@ /% Fetching repositories M

Repositary State
QGI3 Qffical Plugin Repository ; Connecting...

Overall progress:

|

Abort fetching

c. If the plugin list is not displayed, go to ‘Settings’ tab in ‘QGIS Python Plugin
Installer’ window.

d. Click on ‘Add’ to add repositories details.

e. Fill up the details as shown in figure below. And enable the check box besides
‘Enable’

f. Click ‘'OK’ and the repository will be added this will solve the plugin display.

r N
4 Plugin Manager a | ? P |
Settings
Check for updates on startup
every time QGIS starts | v]

Mote: If this function is enabled, QGIS will inform you whenewver a new plugin or plugin update is
available. Otherwise, fetching repositories will be performed during opening of the Plugin Manager
window.

Show also experimental plugins

Mote: Experimental plugins are generally unsuitable for production use. These plugins are in
early stages of development, and should be considered 'incomplete’ or 'proof of concept' tools.
QGIS does not recommend installing these plugins unless you intend to use them for testing
pUrposes.

Plugin repositories

|status Name urL
unavailable QGIS Official Plugin Repository hittp://fplugins. ggis. org fplugins fplugins. xml?ggis=2.0

r ? |

-
./: Repository details

T N
Mame QGIS Official Plugin Repasitory .

URL Ihtu:l:leugins.qgis.orgfpluginsfplugins.ml |

Parameters [ ?qgis=2.0 l

Enabled 2 @

Edit... Delets

Close Help

15
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Once you are
“connected”

g.

r
/! Plugin Manager

connected with the

Getting started with QGIS

QGIS Repository, the status will turn to

Ea )

Installed

% Getmore

_' “} New
P

Settings
Check for updates on startup

every time QGIS starts

-]

Note: If this function is enabled, QGIS will inform you whenever a new plugin or plugin update is
available. Otherwise, fetching repositories will be performed during opening of the Plugin Manager

Wwinoow.

Show also experimental plugins

purposes.

Plugin repositories

Mote: Experimental plugins are generally unsuitable for production use. These plugins are in
early stages of development, and should be considered 'incomplete’ or 'proof of concept' tools.
QGIS does not recommend installing these plugins unless you intend to use them for testing

IName
—

|URL
—

Status
‘ connected QGIS Official Plugin Repository http://plugins. ggis.org/plugins/plugins. xml?qgis=2.0 l

y

Reload repository

Add... Edit... Delete
Close Help
“ — ——— — —

h. Once the plugins list is displayed, you can search required plugin in ‘Get More’ by its
name in search window or else directly scroll down the list and select the desired

plugin.

-
£+ Plugin Manager

(n)

A=)

i Installed

®

Plugins > Get more (75)

N

' GeoCoding

.pg Google Maps Engine Connector
I LecoS - Landscape Ecology Statis
- DSMEditorRemoteControl

/" RuGeocoder

‘.;f Shapefile Encoding Fixer

.pg Zoom to Postcode

‘Sf ZoomToCoordinates

Search | co L x] : ® names descriptions tags authors
'" Contour plugin

1| Thisisanew plugin

Contour plugin

lines (isolines) and/ or filled
contours a set of data points. Requires
python modules numpy, matplotfib, and
shapely.

49 rating vote(s)
13467 downloads
More info: homepage  tracker

Author: Chris Crook, Lionel Roubeyrie

Available version: 1.0.2 {in QGIS Official Flugin Repository)

Uparade all @ [ Install plugin ]

Close Help

==~

16
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i. Once you select desired plugin the ‘Install Plugin’ button will be enabled. Just click
on it and the plugin will start downloading and will install into QGIS.

i hl
@ Z QGIS Python Plugin Installer |- S|

Installing plugin: Contour plugin
Downloading data. ..

4

j- Once you finish installing the plugin, following message box will be seen. Click ‘OK’
and close the ‘Plugin Manager’

@ ) Plugin installed successfully IEI

Plugin installed successfully

k. Now installed plugin is ready to use.

Exercise 5: Downloading sample Data

23. Go to the www.iget-dst.in website.
24. Navigate to ‘Tutorials = GIS ?Introduction to QGIS’.

HOME ABOUT US TUTORIA ¥ CERTIFICATION CONTA

Projectio
REMOTE SENSING rojection

Georefrencin
GEODATABASE 2e0 g

SPATIAL ANALYSIS e Gegilanod

Digitization

WEB / MOBILE GI5

CUSTOMISATION Data Exploration

Join Tables

25. Now it will direct to the ‘Getting Started with QGIS’. Now click on ‘Download Data’.

2 17
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HOME ABOUT US TUTORI/

Getting started with QGIS MENU

INTRODUCTION TO QGIS

_ ~ PROJECTION

all Quantum G

ing familiar
GEOREFRENCING

to QGIS map

IMAGE REGISTRATION
DIGITIZATION
DATA EXPLORATION

Download PDF + Download Data + JOIN TABLES

26. Save the data on your local drive so that you can access it for next exercises.
Exercise 6: Adding data to QGIS

27.Adding Vector data: In this section we will learn how to load a vector layer to the
QGIS.

a. To add vector layer go to ‘Layer = Add Vector Layer’ or else directly click on vﬂo icon
from the toolbar.
4 QGIS 2.0.1-Dufour

@ Project  Edit  View LayerDSetﬁngs Plugine Vector Raster Date

Mew b
2 Embed Layers and Groups. ..
. | pdd Vector Layer... Cirl +5hift+V
| : %, Add Raster Layer... Ctrl+5hift+R
W Add PostGIS Layers... Cirl +5hift+D
A% Add Spatialite Layer.. Cirl +5hift+L
' ’J Add MS5QL Spatial Layer... Ctrl4+5hift-+HM
[+ @), Add Orade Spatial Layer... Ctrl+5hift+0

b. Now ‘Add vector layer’ popup window will open up. Click on ‘Browse’. Then you will
be directed to a navigation window. Navigate to the local directory where you have
saved the sample data downloaded in Exercise 5.

et 18
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4 Add vector layer
Source type
® File Directory
Encoding | System
Saurce

Dataset

Database

7 1=]

Protocol

-

®

corresponding folder will be displayed.

window.

Select the file type as ESRI shapefilelOGR], now all the shapefiles

-
)
&

# Open an OGR Supported Vector Layer

gﬂ Subversion @
| Videos

#d Homegroup

m

18 Computer
&, Local Disk [C:)
=a Lenovo (D:)
s KARMA (G ||
—a Sotwares_Win7

S
(W) | L « IGET_GI5 001 IntroQGIS » IGET_GIS 001 Data ~ | 4| [ Search IGET.GI5_ 001 Data P |
Organize * Mew folder =~ [ @

= Documents  *  Name Date modified Type

J'r‘ Music -
= || ] Lakesshp 1/22/20139:28 AM__ SHP File |
k| Pictures

s Anandhamulu _ |

n | @r

File name: Lakes.shp

+ | ESRI Shapefiles [OGR] (*shp =5 ||

I[ Open I [ Cancel ]

e. Now vector layer will be loaded to your ‘Map canvas’

in the

Select the ‘Lakes.shp’ file and click ‘Open’ and again ‘Open’ in ‘Add vector layer’

19
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A QGIS 2.01-Dufour [S=mfef X
Project Edit View Layer Settings Plugins Vector Raster Database Processng Help

DEEROR RO EL, A APLLRR A6 - M- B8E=-0 % @O BW
ﬂ?v y [_a‘ =] E,'L.J; Oa: E g & & ﬂ Wy nhf; n{_‘ ke @

Layers

'n

#o

|

=

/ Layers | Browser |

g Shortast path

@ Start '

% (73.8545,18.4579)

. | st

o

,n Criterion Length =

V;v Length

: Time:

Calculate Export | Clear
Siren

Coordinate: 73.84276, 154817 16458 - |[9][ Render | Epseiasas
] —— |

28. Adding Raster Layer

a. To add raster layer go to ‘Layer > Add Raster Layer’ or else directly click on 'U icon

from the toolbar.

q’: QGIS 2.0.1-Dufour a
Project Edit  View { Layer )Settings Plugins Vector FRaster Date
e8| o |
L ] Embed Layers and Groups...

. Add Vector Layer... Cirl+5hift-+v
Add Raster Layer... Cirl+5hift+r.

¥y | B X/ (2 17 Add Spatialite Layer... Ctrl-+Shift+.
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@, Add Orade Spatial Layer... Ctrl+5hift+0

&9, Add Orade GeoRaster Layer...

b. Now ‘open a GDAL supported Raster Data Source’ window will popup, click on
‘Browse’.

c. All the raster format files will be displayed. Select the required file i.e.,

‘Southpune toposheet.tif” and click ‘Open’. If ‘Coordinate Reference System Selector’
will window popup, click on ‘OK’.
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d. Now right click on the ‘SouthPune Toposheet’ layer under Layers - click on ‘Zoom to
layer Extent’ The raster file will be opened in Map View.
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e. Now you can see the loaded South Pune Toposheet in the QGIS map canvas
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